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Trademarks
All brands and product names in this manual are trademarks of their respective holders.

Copyright
All rights reserved. No part of this publication may be reproduced, transmitted, transcribed, stored in
a retrieval system, or translated into any language or computer language, in any form or by any
means, electronic, mechanical, magnetic, optical, chemical, manual, or otherwise, without the prior
written permission of iVina Inc.

Material scanned by this product may be protected by governmental laws and other regulations,
such as copyright laws, the customer is solely responsible for complying with all such laws and
regulations.

Warranty
The information contained in this document is subject to change without notice.
iVina makes no warranty of any kind with regard to this material, including, but not limited to, the
implied warranties of fitness for a particular purpose.

iVina shall not be liable for errors contained herein or for incidental or consequential damages in
connection with the furnishing, performance, or use of this material.

FCC Radio Frequency Interference Statement

This equipment has been tested and found to comply with the limits for a class B digital device,
pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses, and can
radiate radio frequency energy and, if not installed and used in accordance with the instruction
manual, may cause harmful interference to radio communication. However, there is no guarantee
that interference will not occur in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be determined by turning the equipment off
and on, the user is encouraged to try to correct the interference by one or more of the following
measures:

− Reorient or relocate the receiving antenna.
− Increase the separation between the equipment and receiver.
− Connect the equipment into an outlet on a circuit different from that to which the receiver is

connected.
− Consult the dealer or an experienced radio/TV technician for help.

FCC CAUTION:  To assure continued compliance, (example - use only shield interface cables
when connecting to computer or peripheral devices).   Any changes or modifications not expressly
approved by the manufacture of this device could void the user's authority to operate the
equipment. This device complies with Part 15 of the FCC Rules.  Operation is subject to the
following two conditions: (1) This device may not cause harmful interference, and (2) this device
must accept any interference received, including interference that may cause undesired operation.

Responsible Party: iVina INC.
732 Sussex Place, Milpitas,  CA 95035,
USA

Telephone Number: +1 (510) 368-8889
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EC Declaration of Conformity

Manufacturer's Name: iVina Inc.

Manufacturer's Address:              732 Sussex Place, Milpitas,  CA 95035, USA

declare that the product

Model Number :  iVina 1200U

conforms to the following Product Specifications:

Emission: EN 50081-1 (1992)
EN 55022 (Class B) (1994) (Conducted/Radiated)
EN 61000-3-2 (Hormonics)(1996)
EN 61000-3-3(Flicker) (1995)

Immunity: EN50082-1 (1992)
IEC 1000-4-2 (ESD) (1995)
IEC 1000-4-3 (RS) (1995)
IEC 1000-4-4 (EFT/Burst) (1995)
IEC 1000-4-5 (SURGE) (1995)

Safety:
Compliance:

Low Voltage Directive 73/23/EEC
UL , C-UL , TUV/GS
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Chapter 1  INTRODUCTION

Thank you for purchasing iVina 1200U color image scanner.  iVina is one of the leading company in
the world to deliver high quality image scanner.

iVina 1200U is built in with the most advanced USB(Universal Serial Bus) interface which features
extremely easy hook-up to your computer and much faster transmission speed.  Moreover, iVina
1200U is equipped with evident push buttons at the front. These buttons feature one-step
operation, which makes scanning intuitive, quick, and virtually user friendly.

To ensure the optimum performance of the scanner, please take a few minutes to read through
this manual before you install and operate the scanner. The manual contains valuable information
of how to unpack, install, operate, and maintain the scanner properly.  Figure 1-1 below shows the
package contents.  Please check if all items are well received.  If there is any item missing or
damaged, please contact your nearest dealer immediately for replacement.

Figure 1-1 Package Contents

Note:  When unpacking the scanner, retain the packing material and shipping box in case
you may transport the scanner in the future.

1. Scanner main unit

2. Bundled Software CD
& Quick Guide

3. Power adaptor

4. USB cable

2

4

1

3
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Chapter 2  SCANNER INSTALLATION

PRECAUTIONS

v Keep the scanner out of direct sunlight.  Direct exposure to the sun or excessive heat may
cause damage to the unit.

v Do not install the scanner in a humid or dusty place.

v Be sure to use the proper AC power source.

v Place the scanner securely on an even, flat surface. Tilted or uneven surfaces may cause
mechanical problems.

 

UNLOCKING YOUR SCANNER

To protect the scanning unit from damage during transportation, a lock switch is designed at the
back of the scanner to keep the scanning unit from moving.   To unlock the scanner, move the
lock switch up as shown in Fig. 2-1.

 “Unlock” position    “Lock” position

Figure 2-1  Unlocking the Scanner

Note: When you need to transport the scanner, be sure to move the lock switch to the
“lock position”; otherwise , unexpected damage should cause the scanner malfunction and
void the warranty.
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CONNECTING THE CABLES

Before setting up the iVina 1200U, please take a glance at the rear side of iVina 1200U as shown
in Figure 2-2.

Follow the instructions below to connect iVina 1200U to your computer as shown in Figure 2-3.

1. Connect the small end of the power adapter into the power jack on the back of the scanner.

2. Plug the large end of the power adapter to the power outlet. Now, the scanner will be
automatically powered on.

3. Connect the rectangular end of the supplied USB cable to the USB port of your computer and
the square end to the USB port on the back of the scanner.

Figure 2-2 Rear view

Figure 2-2 Cable connection

1.  PC USB port(rectangular style)
2.  Your computer
3.  USB cable(supplied)
4.  Scanner
5.  Power adapter

1

2
3

1.  Scanner
2.  Power jack
3.  USB port(square style)

1

2

3

4

5
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PLACING YOUR ORIGINAL

Open the document cover and then place your original face down on the document glass as shown
in Fig. 2-4.  Make sure to align the upper right corner of your original to the alignment mark.

Figure 2-4 Placing the original

1. Document cover

2. Your original

3. Alignment mark

4. Document glass

1

2

4
    3
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Chapter 3  SOFTWARE INSTALLATION

SYSTEM REQUIREMENT

To run iVina 1200U at rated speed, the following minimum requirements are highly recommended:

• IBM compatible PC 586, Pentium or later

• Microsoft Windows 98

• One USB(Universal Serial Bus) port

• 100 Megabytes of available hard disk space for installation

• 16 Megabytes of RAM (32 Megabytes or higher recommended)

• A video graphics array (VGA) monitor

• A Microsoft Windows-compatible pointing device (e.g., mouse)

• A CD-ROM drive
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THE INSTALLATION PROCEDURES

LET WINDOWS IDENTIFY YOUR USB SCANNER

1. Turn on your computer.

2. Connect the supplied power cable and the USB cable.(See Chapter 1)

3. Windows will now prompt a series of “Add New Hardware Wizard” in succession to install the

necessary software for the new hardware.  Follow these steps to complete the installation.

1. When the initial “Add New Hardware
Wizard” dialog as shown in Figure 3-1 is
prompted, Choose “Next”.

 
 Figure 3-1

2. Insert the supplied CD-ROM into your
current CD-ROM drive.

3. When the next “Add New Hardware
Wizard” dialog as shown in Figure 3-2 is
prompted, choose “Search for the best
driver for your device.” and then choose
“Next”.

 
 Figure 3-2

4. When the “Add New Hardware Wizard”
dialog as shown in Figure 3-3 is
prompted, choose “CD-ROM drive” and
“Next”.

 
 Figure 3-3

5. When Windows 98 has detected iVina 1200U
as shown in Figure 3-4, choose “Next”.

 
 Figure 3-4

6. Follow the instructions to insert Windows 98
CD-ROM as shown in Figure 3-5 and choose
“OK”.

 
 Figure 3-5

7. Choose “Finish” when the finish message
displays as shown in Figure 3-6.

 

 Figure 3-6
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START INSTALLING THE SOFTWARE

 
1. Insert the supplied CD into your CD-ROM.  The

Installation menu as shown in Figure 3-1
appears.

 Note: If the Installation menu fails to appear, an
alternative method is to click the Start button on
the task bar, choose Run, and type
“d:\cdsetup.exe” (D: your CD-ROM drive in use)
and click O.K.

2. Click “Install Software”.  A second menu as
shown in Figure 3-2 appears.  This menu lists
various software contained in the CD, including
the scanner driver and the bundled software
applications such as  MGI PhotoSuite, Xerox
TextBridge OCR, and Button Manager, and
PaperPort.

3. Follow the on-screen instructions to install the
scanner driver and all the applications
individually.

4. Restart the computer after the above installation
have been completed done.

 
 Figure 3-1

 Figure 3-2
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Chapter 4  CUSTOMIZING YOUR BUTTON

PREFERENCES

A GLANCE AT THE BUTTONS

 
 Figure 4-1 A glance at the buttons

BUTTON FUNCTION

COPY BUTTON

A press of the Copy button allows you to get an immediate copy for your scanned image directly
from your printer.

OCR BUTTON

A press of the OCR button allows you to convert your original text into editable text with a word
processor.

SCAN BUTTON

A press of the Scan button allows you to scan your photo and display the image on the desktop of
PaperPort, the powerful document management application.

EMAIL BUTTON

A press of the Email button allows you to send your scanned image to your email application as an
attached file.
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CUSTOMIZNG YOUR BUTTON PREFERENCES

CUSTOMIZE YOUR COPY PREFERENCES

1. After installing the Button Manager software application and restarting your computer, the
Preferences dialogs box will be automatically displayed as shown in Figure 4-1.

      An alternative method to prompt the Preferences dialog box is to double-click the iVina Button

Manager   icon at the right corner of your task bar and choose “Preferences” when

a pop-up menu  appears.

Figure 4-1

Note:  If the iVina Button Manager icon at your task bar contains an exclamation mark like  
, this means you have not selected the right scanner.  Please click the iVina Button Manager
icon then choose “Select scanner” and select “iVina 1200U”.  Finally choose “connect
scanner”.  Then, the exclamation mark will disappear.

2. To customize the Copy preferences, please follow these steps

Figure 4-2 iVina Copier

1). Check to display the iVina Copier as shown in Figure 4-2 which allows you to operate it
as a normal copier.

 To customize your iVina Copier preferences, please refer to next page.

2). Choose the proper image type. (See Chapter 6 for more detail about image types.)

3). Choose the proper scan size from a list of Letter, A4, A5, 3”x5”, Business Card, etc.

4). Choose the proper resolution.  (See Chapter 6 for more detail about resolutions.)

5). Adjust the brightness degree by moving the slider to the right or left.

6). Choose your printer.

7). Choose ”OK” to save the above settings.

1

2
3
4

5

6
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CUSTOMIZE YOUR IVINA COPIER PREFERENCES

1. If  the item “Display Copier UI” was previously selected in the Copy preferences dialog box,
the iVina Copier window below will be displayed after pressing the Copy button.

 

 

Figure 5-1 iVina Copier window

2. Press the Preferences button to display the iVina Copy preferences dialog box.  The
Preferences dialog box allows you to change the settings to produce the best copy result.  For
more on choosing the best setting for your original, please refer to Chapter 6.

 

 

 Figure 5-2 Copier Preferences dialog box
 

1). Resolution:  Select the proper resolution. (Refer to Chapter 6.)

2). Scan Size:  Select the proper scan size including Max., Letter, A4, B5, A5, and
Auto Crop.   Auto crop is a convenient feature to automatically crop your
scanned image to fit your existing paper even if your original is not aligned near
the alignment mark.  This is particularly useful if your printer comes with fit to
page feature.

3). Mode:  Select the proper image mode including Gray, LineArt, Halftone,
Background Removal, Auto.    Background Removal can automatically
remove the unwanted background color for your original to sharpen your text.
Auto is an optimized mode regardless of the contents of your original.

5

4

3

2

1

67

1. Copy count
2. Brightness
3. Contrast
4. Start Black & White copy
5. Start Color copy
6. Preferences
7. Exit

1.
2.
3.

1.
2.
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CUSTOMIZE YOUR OCR PREFERENCES

1. Repeat step 1 in the previous section Customize your Copy preferences.

2. In the Preferences dialog as shown in Figure 4-1, choose the “OCR” tab to display the OCR
preferences dialog box.

3. To customize your OCR preferences, please refer to the following steps.

 
 Figure 4-3 OCR Preferences dialog box

 
1). Choose the proper scan size from a list of Letter, A4, A5, 5”x3”, Business Card, etc.

2). Choose the proper resolution (We recommend to choose 300 dpi).  (See Chapter 6 for
more detail about the resolutions.)

3). Adjust the brightness degree by moving the slider to the right or left.

4). Choose the location of your word processor.

5). Choose your desired language for your original text.

6). Choose ”OK” to save the above settings.

 

1
2
3

4
5
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CUSTOMIZE YOUR SCAN PREFERENCES

 
1. Repeat step 1 in the previous section Customize your Copy preferences.

2. In the Preferences dialog as shown in Figure 4-1, choose “Scan” tab to display the Scan
preferences dialog box.

3. To customize the Scan preferences, please refer to the following steps.

 

  
Figure 4-3 The Scan Preferences dialog

1). Choose the proper image type. (See Chapter 6 for more detail about image types.)

2). Choose the proper scan size from a list of Letter, A4, Business Card, etc.

3). Choose the proper resolution.  (See Chapter 6 for more detail about the resolution.)

4). Adjust the brightness degree by moving the slider to the right or left.

5). Choose ”OK” to save the above settings.

1
2
3
4
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CUSTOMIZE YOUR E-MAIL PREFERENCES

1. Repeat step 1 in the previous section Customize your Copy preferences.

2. In the Preferences dialog box, as shown in Figure 4-1, choose “Email” tab to display the Email
preferences dialog box.

3. To customize the Email preferences, please refer to the following steps.

  
Figure 4-4 the Email Preferences dialog

1). Choose the proper image type. (See Chapter 6 for more detail about image types.)

2). Choose the proper scan size from a list of Letter, A4, Business Card, etc.

3). Choose the proper resolution.  (See Chapter 6 for more detail about the resolutions.)

4). Adjust the brightness degree by moving the slider to the right or left.

5). Choose ”OK” to save the above settings.

1
2
3
4
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Note #1:  Followings are the respective procedures to set up the default e-mail software application
for several popular e-mail software applications such as Outlook Express, Netscape Messenger, or
Eudora:

Outlook Express 4.x

1). Select Options from the Tools menu in Outlook Express.
2). In the Options dialog box, click the General tab.
3). Select the “Make Outlook Express my default e-mail program” option.
4). Select the “Make Outlook Express my simple MAPI client” sub option.
5). Choose “Apply” and close Outlook Express.

Outlook Express 5

1). On the Tools menu, click “Options”.
2). On the General tab, click “Make Default” next to “This application is the default mail

handler”.
3). Click OK.

Netscape Messenger

1). Select Preferences from the Edit menu in Netscape.
2). From the category list, select Mail Server from the Mail & Groups item.
3). Click the More Option button.
4). From the More Mail Server preferences dialog box, select Use Netscape Messenger

from MAPI-based applications.
5). Close Netscape Messenger.

Eudora

1). Select Options from the Tools menu in Eudora.
2). From the category list, select MAPI.
3). Select “Always from the USE QUALCOMM Eudora MAPI server” option.
4). Choose “Apply” and close Eudora.

 
 
 Note #2: The following table lists the major default settings for the linked applications:

 
Setting Copy OCR Scan Email

  Image Type  Black & white  Black & white True color True color
Scan Size Letter Letter Letter 6”x4”
 Resolution  100 dpi  300 dpi 100 dpi 100 dpi
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Chapter 5  WORKING WITH THE PUSH BUTTONS

This section provides the simple operating steps with illustrations to make the best of the button
scanner.

MAKING YOUR FIRST COPY

1. Place your original face down on the document glass.

2. Press the Copy button.  The scanning message is first displayed, and then,  in a second,  the
copying is done through the designated printer.

 Or

2.  If  the item “Display Copier UI” was previously selected in the Copy preferences dialog box,
when you press the Copy button, the iVina Copier window shown below will be displayed to
allow you to access various copy features and operate it just like a normal copier.

 

 

Figure 5-1 iVina Copier window

5

4

3

2

1

67

1. Copy count
2. Brightness
3. Contrast
4. Start Black & White copy
5. Start Color copy
6. Preferences
7. Exit
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SCANNING YOUR TEXT TO AN OCR APPLICATION

1. Place your original face down on the document glass.

2. Press the OCR button.  Your original text will be automatically converted into editable text in
a word processor.

 Figure 5-3 A word processor window
 

SCANNING YOUR PHOTO TO PAPERPORT

1. Place your original face down on the document glass.

2. Press the Scan button.  Your scanned image will be displayed in the desktop of PaperPort.

 Figure 5-4 PaperPort desktop
 
 

 Note:
 See detailed PaperPort user’s manual to learn how to use the powerful document

management tool.

 
 

Your scanned
image
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SENDING YOUR IMAGE TO AN EMAIL APPLICATION

1. Place your original on the document glass.

2. Press the Email button.  The scanning message is displayed and within a few seconds, your
original image is scanned and sent to the designated email application as an attached file
shown below (See the following illustration.)

Figure 5-5 Netscape Messenger window

Figure 5-6 Outlook Express window

1

1.  Your scanned image
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Chapter 6  SCANNING FROM WITHIN A TWAIN

COMPLIANT APPLICATION

The iVina 1200U provides an alternative method to scan your image without pressing the push
buttons.  You can start iVina TWAIN window from within a TWAIN compliant application to
proceed your scanning task.  The command to start the iVina TWAIN window may vary due to
different software applications.  To check the correct command, please refer to the user manual of
the relevant software application.

STARTING SCANNING FROM WITHIN A TWAIN APPLICATION

1. Start your TWAIN compliant application such as PaperPort (which is bundled in the CD),
or Adobe PhotoShop after placing the document upside down on the document glass.

2. From the File menu, choose Select Source to select iVina 1200U your Twain source.

 

 

 

 

 

 

 

 

 

 

 

 Figure 6-1 Select Source dialog box

 

3. Choose Acquire to prompt the iVina TWAIN window as shown in Figure 6-2.

4. Click the Preview or Scan button to preview or scan your document or image.

*TWAIN: Stands for Technology Without An Interesting Name, an industry-standard protocol which
exchanges information between the application and image acquisition device such as scanner
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Figure 6-2 iVina TWAIN window
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USING IVINA TWAIN WINDOW

IMAGE TYPE

The scanner provides several image types as explained in below:

Line art

Lineart presents the image in black and white only and there are no intermediate shades of
gray in between.  That means each pixel of the image is 100% black or 100% white.   Lineart
is the best choice of image type if you want to scan text, pen or ink drawing.  Since only 1-bit
of black or white information is required for each pixel*, the disk space required for saving
lineart image is only about 1/24 of that required to save 24-bit true color images.

    
Figure 6-3 Lineart Image

*Pixel: A combination of two words: picture and element, a pixel is a single dot on a computer
display or in a digital image.

True Color

Grayscale

Halftone

Error Diffusion

Lineart
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Halftone

In addition to the black and white display, Halftone simulates gray scale by using different size
of dots.  Particularly when you view the image at a certain distance, it looks very closely like a
gray image yet it consumes the least disk space.  Halftone is the picture that we usually see in
newspapers or magazines.  Since Halftone is one type of black and white image, the disk
space required to save a halftone image is 1/24 of that required to save a 24-bit true color
image.

Figure 6-4 A halftone image

Grayscale  (4096  levels gray scale/Internally)

Usually, a single-channel image consists of at least 8-bit or 256 levels of shades of gray in an
image. However, the scanner with 12 bits produces a Gray image with 4096 shades of gray
between pure black and pure white.  Gray is the best choice of image if you wish to scan a
black and white photograph.  With 12 bits of color information per pixel, the disk space
required to save a gray image is eight times more than lineArt and 1/3 of that required to save
a 24-bit true color image.

Figure 6-5 A grayscale image
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Error Diffusion

While presenting black & white image and taking up but a minimum storage space(1/24 of that
of a 24-bit true color image), error diffusion gives good image texture and excellent image
details. Diffusion also minimizes the interference patterns that can occur after scanning
halftone images, such as those found in magazines, books, and newspapers.

Figure 6-6 An error diffusion image

True Color

A 36-bit Color image consists of three 12-bit color channels.  The red, green, and blue
channels are mixed together to create a combination of  one billion(236) colors which give a
more true-to-life quality to the image.   True Color is the best choice if you want to scan a
color photo.

Figure 6-7 A true color image
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SCANNING PARAMETERS & IMAGE CONTROL

Resolution :

The number of dpi (dots per inch) that the scanner uses for a scan. Usually the greater the
number, the higher the resolution.  Yet up to a certain level, the resolution will not be
visually increased but the disk space will be increased.  A higher resolution (over 600 dpi)
will only be recommended when you need to scan a small area under True Color mode.

Resolution: 50 dpi Resolution: 150 dpi

Tips:

1.  For your information, an A4 size color image scanned at 300 dpi at True Color mode consumes
approximately 25 MB of disk space. A higher resolution (usually means over 600 dpi) is
recommended only when you need to scan a small area at True Color mode.

2. You can also refer to the following table to choose a proper resolution while applying your image
to other application.

                 Scanner Settings

Application

Image Type Resolution
(dpi)

File, Fax, E-mail Your Document LineArt 200

View, Copy, Edit Your Color Picture True Color 100

OCR* Your Document LineArt 300

*OCR:  Stands for Optical Character Recognition, the process to convert an image to a text format.

Resolution

Brightness

Contrast
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Brightness:

Adjusts the lightness or darkness of an image.  The higher the value, the brighter the
image.

Decrease your Brightness Normal Increase your Brightness

Contrast:

Adjusts the range between the darkest and the lightest shades in the image.  The higher the
contrast, the bigger the difference of the gray level.

Decrease your Contrast Normal Increase your Contrast
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Auto Level:

Optimizes the scanned image.

Before Auto Level After Auto Level

Auto Area:

Automatically sets the whole document as the scan area, no matter what its size.

Before Auto Area After Auto Area

Auto Level
Auto Area
Descreen
Color Matching
Reset

Advance Setting

Speed Mode

Image Information

Set Gamma

Measurement Unit

Quality Mode

Invert
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Descreen:

 Eliminates the Moire patterns commonly found in printed matter.

                           Before descreen                   After descreen

        

Color Matching:

Adjusts the color quality of the image to make it close to the original.  This function uses
default parameters to adjust the image.

Before Color Matching After Color Matching

Reset:

Resets the scanning parameters you set.

Invert:

The invert command reverses the brightness and the color in the image.  For color images,
each pixel will be changed into its complementary color at the command of Invert.

Original After Invert
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Advance Settings:

The Advance Settings provides several functions such as Dynamic Background Removal,
Color Drop-out.   These functions are briefly explained as below:

1).  DBR(Dynamic Background Removal) - Apply exclusively when you need to scan as an
Lineart image .  The DBR function incorporates a few enhanced options to allow you to
remove background color to sharpen your text or drawing.

Original(Color picture) After applying DBR option

2).  Color drop-out - Apply exclusively when you need to scan as a black and white image

The Color drop-out function allows you to remove one of the R(Red), G(Green), or B(Bue)
color or to convert all the color data into Neutral Gray.    For example, if you want to
remove the text or background in blue color,  simply check the Blue Channel then the text
or background in blue color will be removed.   On the other hand, if your original contains
various color data, then check the Neutral Gray to retain all the color data in gray since
removing either one of the red, green, or blue color will inadvertently affect the rest color
data as every color contains different elements of each of the red, green, and blue channel.
See the result below:

Your original with blue color background    After click the B(Blue) channel

Your original with red watermark After click the R(Red) channel
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Quality/Speed Mode:

Users can select the mode to perform scanning according to their own need.  Select quality
mode scanning if your emphasis is on the quality of the scanned image.  Or you can select
speed mode scanning if you want to speed up the scanning process.

Measurement Unit:

Represents the different measuring systems to be used in each scan.

Pixel Inch Cm

Image Information:

Gives related information of the scanned image.

Set Gamma:

Adjusts the midtone of the image yet without losing details of the lightest and the darkest
areas at the same time.

Gamma Value: 1.0 Gamma Value: 1.4 Gamma Value:  2.0
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SCANNING

Preview:   Previews your image roughly and allocates the area  to be scanned.

Scan: Execute the Scans action.

Exit: Cancels the current job.

 Document Size:  To designate the size of your document, just click on its icon on the margin of
the preview window.

 
 As shown in the figure below, in the Preview window, you can define the area to be scanned by

dragging the four cursor auxiliary lines.
 

 
 
 
 

Scan size

The cursor auxiliary line

The preview
window
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Chapter 7  CARE AND MAINTENANCE

CLEANING

There are times the document glass is contaminated with dusk or toner particles.  To ensure
quality scanning result, please wipe the document glass occasionally.

To clean the document glass,

1.  Open the document cover as shown in Figure 7-1.

2.  Dip a soft clean cloth with isopropyl alcohol(95%).  And gently wipe the document glass until
the dusty particles are thoroughly removed.

 

  

 Figure 7-1  Cleaning the document glass

The document
glass
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Chapter 8  TROUBLESHOOTING

FREQUENTLY ASKED QUESTIONS

Question:  When the scanner is powered on, it makes noises and won’t stand ready.

Answer: There are two possibilities:

1) You might fail to push the scanner shipping lock to its “use” position.  If this is the

case, pull the scanner status switch to its “use” position first.

2) The scanner is not placed on an even, flat desktop surface.  This may cause the

scanner to malfunction.

Question:   The scanner is powered on, but the lamp does not light up.

Answer: The lamp is probably out of order.  Contact your local dealer or distributor to replace

the lamp. For your information, the average life time of the lamp is about 15,000 hours

and the operating temperature for the scanner is between 10°C(50°F) and

40°C(104°F).

Question:   While scanning, the scanner often makes noises, or it scans back and forth.

Answer: Usually this means the memory of your computer is not enough or the speed of your

CPU too slow.   Please try to increase your memory to at least 32M.

Question:   Why is it that the scanned image always comes out to be too dark?

Answer: 1) Modify the Gamma setting to1.8~2.2 for your monitor and, when printing, set the

Gamma setting to 2.2 for your printer.

2) Adjust the Brightness setting from the user interface to get a brighter image.

Question:   The scanner works well except for the line art image.  The lines in the image
seem to be much thicker than the original one.

Answer: Increase the Brightness or adjust the Threshold setting to improve line art image.
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TECHNICAL SUPPORT

iVina provides technical support for 1200U at iVina Technical Assistance Center.  Before contact
with us, please prepare the following information.

v Scanner serial & revision number (located on the bottom
of the scanner)

v Hardware configuration (e.g., your host type, RAM size, free disk space, etc.)
v The name and version of your software application
v The version of your scanner driver.

Please contact us at:

        iVina  Inc.

Address: 6815 Mowry Ave. Newark CA 94560, USA

Telephone
number:

+1 (510) 739-2369

Fax number: +1 (510) 739-6060
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Chapter 9  SPECIFICATIONS

All specifications are subject to change without notice.

MODEL:  iVina 1200U

Scanner Type:

Optical Resolution:

Maximum Resolution:

Scanning Modes:

Document Size:

Interface:

Power Source:

Power Consumption:

Dimensions: (WxDxH):

Weight:

Flatbed Scanner with Push Buttons

600 dpi * 1200 dpi (H*V)

19200 dpi

Black & White mode

Halftone mode

Error diffusion

Grayscale(12 bits scanning/8 bits output)

Color(36 bits scanning/24 bits output)

8.5” x 11.7”(WxH)

USB(Universal Serial Bus)

100Vac~240Vac, 50~60Hz, external

12 watts(12Vdc, 1A)

470x260x100(mm)

2.9kg(6.3lbs)
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